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Abstract

These Application Notes describe the procedure for configuring Windstream (BroadSoft)
Session Initiation Protocol (SIP) Trunking with Avaya IP Office.

Windstream (BroadSoft) SIP Trunking provides PSTN access via a SIP trunk between the
enterprise and Windstream as an alternative to legacy analog or digital trunks. This approach
generally results in lower cost for the enterprise.

Readers should pay attention to Section 2, in particular the scope of testing as outlined in
Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases
are adequately covered by this scope and results.

Windstream is a member of the Avaya DevConnect Service Provider program. Information in
these Application Notes has been obtained through DevConnect compliance testing and
additional technical discussions. Testing was conducted via the DevConnect Program at the
Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the procedure for configuring Session Initiation Protocol (SIP)
Trunking between service provider Windstream and an Avaya IP Office solution. In the sample
configuration, the Avaya IP Office solution consists of an Avaya IP Office Server Edition Release
10, Avaya Voicemail Pro, Avaya IP Office Softphone, and Avaya H.323, SIP, digital, and analog
endpoints.

The Windstream SIP Trunking service referenced within these Application Notes is designed for
business customers. The service enables local and long distance PSTN calls via standards-based SIP
trunks as an alternative to legacy analog or digital trunks, without the need for additional TDM
enterprise gateways and the associated maintenance costs.

2. General Test Approach and Test Results

The general test approach was to configure a simulated enterprise site using Avaya IP Office to
connect to Windstream SIP Trunking service system. This configuration (shown in Figure 1) was
used to exercise the features and functionality tests listed in Section 2.1.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent to
the interoperability of the tested products and their functionalities. DevConnect Compliance Testing
is not intended to substitute full product performance or feature testing performed by DevConnect
members, nor is it to be construed as an endorsement by Avaya of the suitability or completeness of
a DevConnect member’s solution.

2.1. Interoperability Compliance Testing
A simulated enterprise site with Avaya IP Office was connected to Windstream SIP Trunking

service via SIP trunk. To verify SIP trunking interoperability, the following features and
functionality were exercised during the interoperability compliance test:

e Response to SIP OPTIONS queries.

e SIP registration.

e Incoming PSTN calls to various phone types. Phone types included H.323, SIP, digital, and
analog telephones at the enterprise. All inbound PSTN calls were routed to the enterprise
across the SIP trunk from the service provider.

e Outgoing PSTN calls from various phone types. Phone types included H.323, SIP, digital,
and analog telephones at the enterprise. All outbound PSTN calls were routed from the
enterprise across the SIP trunk to the service provider.

e Inbound and outbound PSTN calls to/from the Avaya IP Office Softphone.

e Inbound and outbound long holding time call stability.

e Various call types including: local, long distance, international, outbound toll-free, operator
service and directory assistance.

e Codec G.711mu-law and G.729.

e Caller number/ID presentation.
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e Privacy requests (i.e., caller anonymity) and Caller ID restriction for inbound and outbound
calls.

e DTMF transmission using RFC 2833.

e Voicemail navigation for inbound and outbound calls.

Telephony features such as hold and resume, transfer, and conference.

Fax G.711 mode.

Off-net call forwarding.

Twinning to mobile phones on inbound calls.

Avaya Communicator for Windows.

Avaya Communicator for Web Client (WebRTC).

Note: Avaya Communicator for Web client (WebRTC) was tested as part of this solution. The
configuration necessary to support Avaya Communicator for Web client is beyond the scope of these
Application Notes and is not included in these Application Notes. For these configuration details, see
Reference [5].

2.2. Test Results
Windstream SIP Trunking passed compliance testing.

Items not supported or not tested included the following:
e Inbound toll-free is supported but was not tested as part of the compliance test.
e T.38 Fax is not supported.
e Call Redirection using REFER method is not supported.

Interoperability testing of Windstream SIP Trunking was completed with successful results for all
test cases with the exception of the observations/limitations described below.

e SIP OPTIONS — Windstream was not configured to send SIP OPTIONS but responded to
SIP OPTIONS.

2.3. Support

For technical support on the Avaya products described in these Application Notes visit
http://support.avaya.com.

For technical support on Windstream SIP Trunking, contact Windstream at
http://www.windstreambusiness.com/support/customer-support
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3. Reference Configuration

Figure 1 below illustrates the test configuration. The test configuration shows an enterprise site
connected to Windstream SIP Trunking service public IP network. For confidentiality and privacy
purposes, actual public IP addresses used in this testing have been masked out and replaced with
fictitious IP addresses throughout the document.

Located at the enterprise site is an Avaya IP Office Server Edition with the MOD DGTL STA16
expansion which provides connections for 16 digital stations to the PSTN, the extension PHONE 8
card which provides connections for 8 analog stations to the PSTN as well as 64-channel VCM
(Voice Compression Module) for supporting VVolP codecs. The LAN port of Avaya IP Office is
connected to the enterprise LAN while the WAN port is connected to the public IP network.
Endpoints include an Avaya 9600 Series IP Telephone (with H.323 firmware), an Avaya 9508
Digital Telephone, an Avaya Symphony 2000 Analog Telephone, Avaya 1100 Series SIP
Deskphone and Avaya Communicator. A separate Windows PC runs Avaya IP Office Manager to
configure and administer Avaya IP Office.

Mobility Twinning is configured for some of the Avaya IP Office users so that calls to these user
phones will also ring and can be answered at the configured mobile phones.

Windstream
(BroadSoft Platform)
SIP Trunking
192.168.64.176

Avaya IP Office Server

PR T T

SIP/UDP |
[
10.10.97.61
WAN_
Avaya Voicemail Pro
| for IP Office
; ’ Avaya 11x0 SIP 10.10.98.86
Avaya Communicator Avaya 9600-Series
10.10.51 20 - H.3231P Telephone P Telephone

Avaya IP Office
i for Windows

N
T : - S
10.10.98.229

Enterprise LAN Enterprise LAN ()

Digital Phone Analog
Phone / Fax Avaya Communicator for Web
(WebRTC)

Figure 1: Test Configuration for Avaya IP Office with Windstream SIP Trunking Service
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For the purposes of the compliance test, Avaya IP Office users dialed a short code of 8 + N digits to
send digits across the SIP trunk to Windstream. The short code of 8 was stripped off by Avaya IP
Office but the remaining N digits were sent unaltered to Windstream. For calls within the North
American Numbering Plan (NANP), the user would dial 11 (1 + 10) digits. Thus for these NANP
calls, Avaya IP Office would send 11 digits in the Request URI and the To field of an outbound SIP
INVITE message. It was configured to send 10 digits in the From field. For inbound calls,
Windstream SIP Trunking sent 11 (starting with digit 1) digits in the Request URI and the To field
of inbound SIP INVITE messages.

4. Equipment and Software Validated
The following equipment and software/firmware were used for the sample configuration provided:

Avaya Telephony Components
Equipment Release
Avaya IP Office Server Edition 10.0.0.0.0 build 550
Avaya IP Office 500v2 (Expansion) 10.0.0.0.0 build 550
Avaya IP Office Manager 10.0.0.0.0 build 550
Avaya Voicemail Pro for IP Office 10.0.0.0.0 build 550
Avaya 11x0 IP Telephone (SIP) SIP11x0e04.04.23.00
Avaya 9621G IP Telephone (H.323) 6.6.2.29.050316
Avaya Communicator for Windows 2.0.3.237
Avaya Communicator for Web (WebRTC) 1.0.16.1718
Avaya Digital Telephone (9508) 0.45
Avaya Symphony 2000 Analog Telephone N/A
Windstream SIP Trunking Service Components
Component Release
Cisco 2911 ISR G2--CUBE SBC €2900-universalk9-mz.SPA.154-3M2.bin
EDGE Acme SBC — ACME Net-Net 4250 SC6.2.0 Patch 3 (Build 497) Build
Date=02/12/10
BroadSoft R17SP4

Note: Compliance Testing is applicable when the tested solution is deployed with a standalone IP
Office 500 V2 and also when deployed with all configurations of IP Office Server Edition without
T.38 Fax Service.
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5. Configure IP Office

This section describes IP Office configuration to support connectivity to Windstream SIP Trunking
service. IP Office is configured through IP Office Manager PC application. From a PC running IP
Office Manager application, select Start - Programs - IP Office > Manager to launch the
application. Navigate to File > Open Configuration, select the proper IP Office system from the
pop-up window, and log in with the appropriate credentials. A management window will appear
similar to the one shown in the next section. The appearance of the IP Office Manager can also be
customized using the View menu. In some screens presented in this section, the View menu was
configured to show the Navigation pane on the left side, the Group pane in the center, and the
Details pane on the right side. These panes will be referenced throughout IP Office configuration.
Proper licensing as well as standard feature configurations that are not directly related to the
interface with the service provider (such as LAN interface to the enterprise site and IP Office
Softphone support) is assumed to be already in place.

5.1. LAN Settings

In the sample configuration, the SEQT VM was used as the system name and the WAN port was
used to connect IP Office to the public network. The LAN2 settings correspond to the WAN port on
IP Office.

To access the LAN settings, first navigate to System (1) > SEQT VM in the Navigation and then
navigate to the LAN2 - LAN Settings tab in the Details Pane.

e Setthe IP Address field to the IP address assigned to the Avaya IP Office WAN port.

e Setthe IP Mask field to the mask used on the public network.

e All other parameters should be set according to customer requirements.

e Click OK.

Configuration ‘E? SEQTVM* = A AREE

#-& BOOTP (8)

- VolP Security Contact Center
+-{#% Operator (3)

L...:..,}, Solution Systern LAN1  LAN2Z  DNS Voicemail Telephony Directory Services  System Events  SMTP SMDR - VilP
+: User(30) LAN Settings  VolP Network Topology
+ﬂ Group(l)
+-@% Short Code(45) IP Address 10 10 97 61
-85 Directory(0)
£ Time Profile(0) IP Mask 255 . 255 . 25F . 240

----- @ Account Code(0)
+-§3 User Rights(9)

88 Location(0 -
% Location(0) Number Of DHCP IP Addresses 200 =

= -5 SEQT VM
-5 System (1) DHCP Mode
547 Line ) O Server O Client @ Disabled fevenced

-2 Control Unit (8)
-4 Extension ()
§ User (7 Help
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Select the Vol P tab as shown in the following screen.
e The H323 Gatekeeper Enable box is checked to allow the use of Avaya IP Telephones
using the H.323 protocol, such the 9600-Series IP Telephones used in the sample

configuration.

e The SIP Trunks Enable box must be checked to enable the configuration of SIP trunks to
service provider.
e The SIP Registrar Enable box is checked to allow IP Office Soft-phone usage.
e The Layer 4 Protocol, check the UDP, TCP and TLS boxes. Then set UDP and TCP Ports
to 5060, and TLS port to 5061.
e All other parameters should be set according to customer requirements.

=

i# Operator (3)
527 Solution

i-§  User(30)

LAN Settings  VolP Network Topology

e Click OK.
Configuration b SEQT VM~ [ X v
+a BOOTP (&) System LANT LANZ  DNS Voicemail Telephony Directory Services System Events SMTP SMDR VolP VolP Security Contact Center

-~
+ ﬂ Group(1) H.323 Gatekeeper Enable
8% Short Code(45) [] Auto-create Extension Auto-create User [] H.323 Remote Extension Enable
-5 Directory(0)
£ Time Profile(0) H.323 Signaling over TLS Disabled v] 1720 E
-l Account Code((])
-3 User Rights(3)
&8 Location(0) SIP Trunks Enable
-5 SEQT YM .
System (1) SIP Registrar Enable
53 SEQT VM [] Auto-create Extension/User [] SIP Remote Extension Enable
-1 Line (2)
<= Control Unit (8) SIP Domain Name | |
-4 Extension (6)
User (7) SIP Registrar FODMN | |
ﬂ Group (0)
8 Short Code (50) uop UDP Port 5060 = =
B Service (0)
Incoming Call Route (8) Layer 4 Protocol TP TCP Port  [5060 s =
@z Directory (0] = e =
Time szne(o) LS TLSPort (5061 : 061 z
@l P Route (1) —
& Account Code (0) Challenge Expiration Time (sec) 0 -
% License (30)
3 User Rights (9] RTP
ARS (1)
i Location (0) Port Mumber Range
"8 Authorization Code (0) Minimum 40750 = Maximurm 50750 =
+-%23 [PO SP EXP
Port Mumber Range (MNAT)
Minimum 40750 : Mazximum 50750 o
Enzble RTCP Monitering on Port 5003
RTCP collector IP address for phones
Keepalives
Scope RTP-RTCP ~ | Periodic timeout
Initial keepalives Enabled ~ v
< >
OK Cancel Help
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On the Network Topology tab in the Details pane, configure the following parameters:

e Select the Firewall/NAT Type from the pull-down menu that matches the network
configuration. No firewall or network address translation (NAT) device was used in the
compliance test as shown in Figure 1, so the parameter was set to Open Internet. With this
configuration, STUN will not be used.

e Set Binding Refresh Time (seconds) to 60. This value is used as one input to determine the
frequency at which IP Office will send SIP OPTIONS messages to the service provider.

e Set Public IP Address to the IP address of IP Office WAN port. Public Port is set to 5060
for UDP and TCP, and 5061 for TLS.

e All other parameters should be set according to customer requirements.

e Click OK.

Configuration || ¥ SEQTVM"* B9 (X v <>

=R BOOTP (8)
-4 Operator (3)
i---’-;-Sqution System LAN1 LANZ  DNS Voicemail Telephony Directory Services  System Events  SMTP SMDR VolP VolP Security
+-§  User(30)
+1§ Group(1)

Contact Center

LAN Settings VolP  Metwork Topology

+-9% Short Code(45) MNetwork Topology Discovery 2
STUN Server Address STUN Port 3478 =
i Accou.nt Code(0) Firewall/NAT Type Open Internet ~
T---ﬁ‘, User Rights(9)
i &5 Location(0) Binding Refresh Time (sec) 60 =
=I-%=p SEQT VM
= Public IP Address 10 0 97 61 Run STUN Cancel
: X Public Port
+-<2 Control Unit (8)
i Extension (6) upP 3060 =
+§ User (7) =
..... .,a Group (0) TCP 5060 -
+-@% Short Code (50) =
= @ Service (0) TLS 5061 2
+-§P) Incoming Call Route
: e - g ( [] Run STUN on startup v
7 Time Profile (0) a 5
-l P Route (1)
Bl Account Code (0)
B License (30) 0K Cancel Help
N WP

In the compliance test, the LAN1 interface was used to connect Avaya IP Office to the enterprise
site IP network. The LANL1 interface configuration is not directly relevant to the interface with
service provider SIP Trunking service, and therefore is not described in these Application Notes.
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5.2. System Telephony Settings
Navigate to the Telephony - Telephony Tab in the Details pane.

e Choose the Companding Law typical for the enterprise location.

e For North America, U-LAW is used.

e Uncheck the Inhibit Off-Switch Forward/Transfer box to allow call forwarding and call
transfer to the PSTN via the service provider across the SIP trunk.

e Uncheck the Drop External Only Impromptu Conference box to allow the host of 3 way
conference leaving the active call without forcing all the parties off the conference.

e Other parameters are left at default.

e Click OK.

Configuration |

SEQTVM

1) v

=& BOOTP (8)

+-i% Operator (3)

537 Solution

w-§  User(30)

+1ﬂ Group(1)
8% Short Code(45)

-5 Directory(0)
7 Time Profile(0)

-~ Account Code(0)

+---§‘, User Rights(9)

&g Location(l)

-9 SEQT VM

<2 Control Unit (8)

+® Extension (6)

+ I User (T}

.ﬂ Group (0)

+- 8% Short Code (50)

4B Service (0)

e Incoming Call Route (&)
@ Directory (0)

B8 Account Code (0)
% License (30)
ﬁ, User Rights (3)

)
5

a‘ﬂ Authorization Code (0)
4537 PO SP EXP

System LANT  LANZ  DNS
Telephony  Park & Page Tones 8 Music
Dial Delay Time (sec) 4
Dial Delay Count 0

Default No Answer Time (sec) 15

Hold Timeout (sec) 720
Park Timeout (sec) 300
Ring Delay (sec) 5

Call Priority Promotion Time (sec) |Disabled =

Ring Tones SM

Al {[alel| [ale] [Tl Tale] el

Default Currency usD ~
Default Name Priority Favor Trunk ~
Media Connection Preservation Enabled ~
Pheone Failback Automatic ~

Login Code Complexity
[] Enforcement
n =

Complexity

RTCP Collector Configuration
[[] send RTCP te an RTCP Collector

Voicemail Telephony  Directory Services System Events  SMTP

Call Log TUI

SMDR VeolP VolP Security  Contact Center

Companding Law

Switch Line
® U-Law (® U-Law Line
O A-Law () A-Law Line

[] DSs Status
[ Aute Hold

Dial By Mame
Show Account Code
[] Inhibit Off-Switch Forward/Transfer
[] Restrict Network Interconnect

Include location specific information

[ Drop External Only Impromptu Conference
[ Visually Differentiate External Call

High Quality Conferencing
Directory Overrides Barring

[ Advertise Callee State To Internal Callers

Help
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5.3. VOIP Security Settings

When enabling SRTP on the system, the recommended setting is Preferred. In this scenario, IP
Office uses SRTP if supported by the other end, and otherwise uses RTP. If the Enforced setting is
used, and SRTP is not supported by the other end, the call is not established.

Individual SIP lines and extensions have media security settings that can override system level
settings. This can be used for special cases where the trunk or extension setting must be different
from the system settings.

In the compliance testing, Preferred is set at system, trunk and extensions level to allow the system
to fall back to non-security media in case there is issue with SRTP. This would help to avoid
blackout situation within the enterprise network. In some specific deployment, if supported, Enforce
is set at trunk level to ensure the secured communication over the public internet using both
signaling (TLS) and media (SRTP). Navigate to System = VoIP Security tab and configure as
follow:

e Select Preferred for Media. The system attempts to use secure media first and if

unsuccessful, falls back to non-secure media within Avaya IP Office system.
e Other parameters are left as default.
e Click OK.

N

Configuration |:: SEQTVM i v o s 2

- K poOTP (8

: System LANT  LANZ  DNS Voicemail Telephony Directory Services  System Events SMTP  SMDR  VelP
#-¢# Operator (3)

VolIP Security  Contact Center

;---’-j;- Selution
+-§  User(30) ~
+ﬂ Group(1) Media Preferred ~ [] Strict SIPS
+-B% Short Code(43)
~-a¥s Directory(0)
----- 17 Time Profile(0)
""" &3 Account Code(D) Media Security Options
B
48 Lo ighet Encrvotions o
=15 SEQT VM [ rrcp
:ffstseggrpim Authentication RTP
H-F7 Line (2) RTCP
+ = Control Unit (3) Replay Protection
¥4 Edension (6) SRTP Window Size [64
= User (7)
ﬂ Group (0) Crypto Suites
+-@% Short Code (30) SRTP_AES_CM_128_SHA1_80
B Service (D) SRTP_AES_Ch_128 SHAT 32
: e Inceming Call Rou
@ Directory (0) W
Time Profile (0]
o-Jill IP Route (1) -
- Account Code (0] =P
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5.4. Administer SIP Line

A SIP line is needed to establish the SIP connection between IP Office and Windstream SIP
Trunking service. The recommended method for configuring a SIP Line is to use the template
associated with these Application Notes. The template is an .xml file that can be used by IP Office
Manager to create a SIP Line. Follow the steps in Section 5.4.1 to create the SIP Line from the
template.

Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:

e |P addresses.

e SIP Credentials (if applicable).

e SIP URI entries.

e Setting of the Use Network Topology Info field on the Transport tab.

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary after
the SIP Line is created via the template. The resulting SIP Line data can be verified against the
manual configuration shown in Section 5.4.2.

Also, the following SIP Line settings are not supported on Basic Edition:
e SIP Line — Originator number for forwarded and twinning calls.
e Transport — Second Explicit DNS Server.
e SIP Credentials — Registration Required.

Alternatively, a SIP Line can be created manually. To do so right-click Line in the Navigation Pane
and select New - SIP Line (not shown), then follow the steps outlined in Sections 5.4.2.

5.4.1. Create SIP Line from Template

1. Copy the template file (AF-WIND-SIPTrunk-1PO10.xml) to the computer where IP Office
Manager is installed. The file name is important in locating the proper template file in Step
4. The content of this template file can also be found in the Appendix Section of this
document.

2. Import the template into IP Office Manager.
From IP Office Manager, select Tools = Import Templates in Manager. This action will
copy the template file into the IP Office template directory. The default template location is
C:\Program Files\Avaya\lP Office\Manager\Templates.

Lol Avaya IP Office Manager for Server Edition SECT VM [10.0.0.0.0 build 530]
File Edit \View | Tools Help
::I |: Extension Renumber...
SEQT VM ExpD b -
7 Server Edition Service User Managerment n o
Configuratior SIP Line -Line 3
Busy on Held Validation
-~ & BOOTP (2) URI VoIP  SIP Credentials SIP Advanced Engineering
Operator (3) MSM Configuration
= solution Print Button Labels 3 = In Service
User (30) -
338 Group(1) | Import Templates in Manager | | Check 005
B Short Code License Migration | |
-44m [hrecto () o T
I .—.WE-.J m T
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In the pop-up window that appears (not shown), select the directory where the template file
was copied in Step 1. After the import is complete, a final import status pop-up window will
appear (not shown) stating success or failure. Then click OK (not shown) to continue. If
preferred, this step may be skipped if the template file is copied directly to the IP Office

template directory.

To create the SIP Trunk from the template, right-click on Line in the Navigation Pane, then

navigate to New - New from Template - Open from file.

—

Configuration | Line = SIP Line - Line 3
K BOOTP () LineNu... ' LineTypg| SIP Line Transport SIP URI VoIP  SIP Credentials SIP Advanced Engineering
Operator (3) 1 IP Office
soluJior'leccI 2 SIP Line Line Number 3 = In Service
3 ser )
% Group(1) e 3 SIP Line ITSP Domain Mame | |  checkoos
--@X Short Code (43) ™= 19 SIP Line
Directory(0) Local Domain Mame | |
! Time Profile(0) Session Timers
Account Code() URI Type siP >
..... §3 User Rights(8) Refresh Method
_____ 8 Location(0) Location Cloud
E-%=p SEQT V] = Ti
oy ¥1 New N imer (sec)
i Cor] & Cut Chrl+X | |
53 Copy Ctrl+C |D |
Paste Ctrl+V
[ elete tri+Del
Del Ctrl+Del |DD |
@ W Validate | | Redirect and Transfer
----- Inc . -
_____ == Dir | Mew from Template 3 Open from file " - Inceming Supervised REFER
) n ;I;rg Export as Template | | Outgoing Supervised REFER
- fcc Show In Groups Send 302 Moved Termporarily
? IL_che Customize Columns... Outgeing Blind REFER
v e 1 TT

4. On Open pop-up windows, Navigate to Manager > Templates, make sure Template File
(.xml) is the file type selected. Then select the file “AF-WIND-SIPTrunk-1PO10.xml”.
Click Open and OK (not shown).

t Open
- - T
Organize -

 Quick access
B Desktop

‘ Downloads
=] Documents

=| Pictures

IPO10SBCET
IPO10SBCETT

termplate

[ Desktop
@ Onelrive
A Quang
= This PC

<< Awaya » IP Office » | Mana

Mew folder

-~ Mame

How to commar

L

ger ~ manager_files > template

de-DE

en-Us

es-MX

fr-FR
IPSET-UNISTIM-C7M
it-1T

VM Greeting
manager_files
MemornyCards
nl-ML
Phonelmages
pt-BR

ru-RU
Templates

V3_2 999

zh-Hans

File name:

>
Search template p=
EER (1 | 9
Size
~| | Template Files i ~

5. Once the SIP Line is created, verify the configuration of the SIP Line with the configuration
shown in Section 5.4.2.
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5.4.2. Create SIP Line Manually

To create a SIP line, begin by navigating to Line in the left Navigation pane and then right-click to
select New - SIP Line (not shown).

On the SIP Line tab in the Details Pane, configure the parameters as shown below:

To create a SIP line, begin by navigating to Line in the left Navigation Pane, then right-click in the
Group Pane and select New - SIP Line (not shown). On the SIP Line tab in the Details Pane,
configure the parameters as shown below:

e Set ITSP Domain Name to the enterprise domain so that IP Office uses this domain as the
host portion of SIP URI in SIP headers such as the From header. In this testing, it was left
blank as Windstream system was set to receive host portion of SIP URI as IP address.

e Check the In Service box.

e Check the Check OOS box. With this option selected, IP Office will use the SIP OPTIONS
method to periodically check the SIP Line.

e Incoming Supervised REFER is set to Never as Windstream does not support REFER.
e Outgoing Supervised REFER is set to Never as Windstream does not support REFER.
e Other parameters are set as default values.
e Click OK.
Configuration |E SIP Line - Line 3 g - K| v«
+‘s EOOTP (3()3) 5|pL|"E Transport SIP URI VoIP  SIP Credentials SIP Advanced Engineering
g7 Operator
-5 Selution Line Number 3 = In Service
w-§  User (30)
-5 Group(1) ITSP Domain Name | | checkoos
@K Short Code (45)
a4 Directory(0) Local Domain Name | |
£ Time Profile(0) Secsion Ti
- Account Code(0) URI Type sie ~ ession fimers
+g E;:;E;i%?(g} Location Cloud v Refresh Method Auto e
= QT VM Timer (sec) On Demand o
System (1)
o hesmp SEQTVM
‘T‘. Line (4) Prefix | |
::: 1 National Prefix o |
: 39 International Prefix |DD |
42> Control Unit (8) Country Code | | Redirect and Transfer
-4 Extension (8) .
_= User (T) Name Priarity System Default » Incoming Supervised REFER MNever ~
?;5%5:;23_2550 Description | | Qutgeing Supervised REFER MNever w
}H 2351 H323-2351 Send 302 Moved Temporarily ]
::g i::i :3253225? Outgoing Blind REFER 0
- 2556 5IPS-2536
= 2557 SIPS-2557
ﬂ‘ GFULIE (D]
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Select the Transport tab.

The ITSP Proxy Address is set to IP Address of service provider. As shown in Figure 1,
this IP Address is shown in capture below.

In the Network Configuration area, UDP is selected as the Layer 4 Protocol, and the Send
Port is set to the port number of service provider, 5060.

The Use Network Topology Info parameter is set to LAN 2. This associates the SIP Line
with the parameters in the System - LAN2 - Network Topology (not shown) tab.

Other parameters retain default values in the screen below.

e Click OK.
Configuration | 7 SIP Line - Line 3* i < |>

*‘a BOOTP (8) A | SP Line Transport S|P URI VolP  SIP Credentials SIP Advanced Engineering
-5 Operator (3)
=% Selution ITSP Proxy Address |192.168.64.176 |

+-§  User (30)

+1ﬂ Group(1) ) .

-8 Short Code (45) Metwork Configuration

""" @m Directory(0) Layer 4 Protocol UDp ~ Send Port 3060 =

- Time Profile(0)

----- 8 Account Code(l) Use Network Topology Info | LAN 2 ~ =

+-§5 User Rights(9)

-8 Location(0) Explicit DNS Server(s) 0 0 0 0 0 0 0 0

4B Service (0
- Incoming Call Roi

Calls Route via Registrar

Separate Registrar |

OK Cancel Help

A SIP URI entry Channel 1 is created to match incoming numbers that IP Office will accept on this
line. Select the SIP URI tab, click Add button and then New Channel (not shown) area will appear
at the bottom of the pane. To edit an existing entry, click an entry in the list at the top, and click the

Edit..

. button. In the example screen below, a previously configured entry is edited. For the

compliance test, a single SIP URI entry was created that matched any DID number assigned to an IP
Office user. The entry was created with the parameters shown below:

Set Local URI, Contact and Display Name to Use Internal Data. This setting allows calls
on this line which SIP URI matches the number set in the SIP tab of any User as shown in
Section 5.7.

e Set Identity to Auto and Header to P Asserted ID for Identity.

e Set Sent Caller ID to Diversion Header for Forward and Twinning.

e Set Diversion Header to Auto.

e Associate this line with an incoming line group in the Incoming Group field. This line
group number will be used in defining incoming call routes for this line. Similarly, associate
the line to an outgoing line group using the Outgoing Group field. For the compliance test, a
new incoming and outgoing group 3 was defined that only contains this line (line 3).

e Set Max Calls per Channel to the number of simultaneous SIP calls that are allowed using
this SIP URI pattern.

QT; Reviewed: Solution & Interoperability Test Lab Application Notes 14 of 27

SPOC 10/26/2016 ©2016 Avaya Inc. All Rights Reserved. WINDSIPO10




e Other parameters retain default values and or set according customer requirements.
e Click OK.

SIP Entry Channel 1 is shown below.

Configuration | 7 SIP Line - Line 3 s -F X v <
K soote ] SIP Line Transpert SIPURI WalP  SIP Credentials SIP Advanced Engineering
Operator (3)
=7 Solution URl  Groups Local URI  Contact Display Name Identity Header Originator Mumber Send Caller ID Diversion Header Add...
]a User (30) <Internal> <Internal> <Internal> Auto PAI Diversion
-5 Group(1) —
H--8% Short Code (45)
----- #m Directory(() -
£ 1) Time Profile(0)
= Account Code()
H-§i3 User Rights(9)
""" % Location(D)
%57 SEQT VM
System (1) Edit URI oK
Local URI ‘Use Internal Data v|
Cancel
Contact ‘Use Intemal Data v|
Display Name ‘Use Internal Data v|
Identity
(-4 Extension (6)
w-§ User(7) Identity |Aut0 “ |
----- Group (0]
EJ---g ShortpCode 51 Header P Asserted ID >
----- @B Service (0) o
@ Incoming Call Route (11) Forwarding And Twinning
@& Directory (0) Originator
Time Profile (0) Mumber
[ IP Route (1)
Bm Account Code (0) send CallerID Diversion Header ~
----- = License (30)
#-fi5 User Rights (9)
- ARS (1)
----- i5 Location (0) . .
..... 28 Authorization Code (0) Diversion Header ‘Auto w
175 PO SPEXP Registration 0: <MNone> w
Incoming Group
Max Sessions 10 =
Help
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Select the VoI P tab to set the VVoice over Internet Protocol parameters of the SIP line. Set the
parameters as shown below:

e The Codec Selection can be selected by choosing Custom from the pull-down menu,
allowing an explicit ordered list of codecs to be specified.

e Selecting G.711 ULAW 64K and G.729(a) 8K CS-ACELP codec supported by the
Windstream Trunking service, in the Session Description Protocol (SDP) offer.

e Set Fax Transport Support to G.711 from the pull-down menu (T.38 faxing is not currently
supported by Windstream).

e Set the DTMF Support field to RFC2833/RFC4733 from the pull-down menu. This directs
IP Office to send DTMF tones using RTP events messages as defined in RFC2833.

e Check the Re-invite Supported box.
e Check the PRACK/100rel Supported box.
e Media Security is set to Disabled.
e Default values may be used for all other parameters.
e Click OK.
Configuration | 7 SIP Line - Line 3 ef - < >
R EJOOTP (3(13] A | SIP Line Transport SIP URI ValP " SIP Credentials SIP Advanced Engineering
g N
l...f.?_ S:E:D:r [] Local Hold Music
: ;’“ g::['(:(?)] Re-invite Supported
+-@% Short Code (45) Codec Selection Custom > [ Codec Lockdown
D (1)
;‘i\ Ti':;t;z:”)e@ L;n:15$1mxm — 5;'::ESLAW — [ Allow Direct Media Path
+ ; ﬁ:;:;ir;thio(;;(m 6.722 64K = G::vzg(a) 8K C5-ACELP Force direct media with phones
@5 Location(0) PRACK/100rel Supported
LR
HEE . s
11 Control Unit (8)
:? S;t:rn(%un ® Fax Transport Support | G.711 ~
L@ Group () -
1 BX Short Cote 51 DTMF Support RFC2833/RFC4733
Service (0) . . . "
i e Incoming Call Route (1 Media Security Disabled
Directory (0]
7 Time Profile (0
: @ 1P Route (1) Help
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5.5. Short Code

Define a short code to route outbound traffic to the SIP line. To create a short code, select Short
Code in the left Navigation Pane, then right-click in the Group Pane and select New (not shown). On
the Short Code tab in the Details Pane, configure the parameters for the new short code to be
created. The screen below shows the details of the previously administered “8N;” short code used in
the test configuration.

e Inthe Code field, enter the dial string which will trigger this short code, followed by a semi-
colon. In this case, 8N; this short code will be invoked when the user dials 8 followed by
any number.

e Set Feature to Dial. This is the action that the short code will perform.

e Set Telephone Number to the value shown in the capture bellow. This field is used to
construct the Request URI and To headers in the outgoing SIP INVITE message. The value
N represents the number dialed by the user. The host part following the “@” is the domain of
the service provider network.

e Setthe Line Group Id to the outgoing line group number defined on the SIP URI tab on the
SIP Line in Section 5.4. This short code will use this line group when placing the outbound
call.

e Others parameters are at default values.

e Click OK.

Configuration ‘ Short Code T 8N;: Dial* £k - X|wv|<]|>
------ R BOOTP (8) ~ | Code Telephone Nu™ || Shart Code

Operator (3] X1 NE N

Solution s Cod

_____ g B | N

..... 2% Group(1) - Feature Dial ~

----- 82 Short Code (45) Baxr14rN N - -

- Directory(0) x5 Telephone Mumber

----- 1% Time Profile(0) 15 ) _

..... ; Account Code(0) ox-17 iy Line Group 1D 3 v

""" 3 User Rights(9) * ocale nited States ~

..... 5 Location(0) :: ::i Local United States (US

-5 SEQT VM * Force Account Code |:|

L“"_ S;.rstem ) 207N N Force Authorization Code []

- Line {4) BRE21NE N

= Control Unit (8) X+20

-y Extension (6) Fyveee

: User (7) )

,a Group (0) PHEITNE N

-~ @% Short Code (51) B33 N

B Service (0) Be3an; N

43 Incoming Call Route BRI5NE N

a4 Directory (0) "

£ Time Profile (0) “*35,* )

il IP Route (1) :: 3TNE N

i

: ﬁcccezzgifo?de([)] e = Y oK Cancel Help
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For incoming calls from mobility extension to FNE features hosted by IP Office to provide Dial
Tone functionality, Short Code FNEOO was created. The FNEOO was configured with the following
parameters.

e Inthe Code field, enter the FNE feature code as FNEOO for Dial Tone.

e Set the Feature field to FNE Service.

e Set the Telephone Number field to 00 for FNEOQO.

e Setthe Line Group ID field to 0.

e Retain default values for other fields.

e Click OK.

Configuration ‘ Short Code BIEE FNE0O: FNE Service i X|lwv|<|>

K BOOTP(8) ~ | Code Tele * [ Short Code

Operator (3) X5 NE N
..... ser
..... .ﬂ Group(1) 47 Feature FME Service ~
----- 9% Short Code (45) L
..... &= Directory(D) P49 Telephone Mumber
£ Time Profile(0) #x%*50
i 0 e
_____ e e 0] o Line Group D o
---- &3 User Rights(9) . Locale United States (US Er ~
----- & Location(D) 52 )
-39 SEQT VM PR5NE N Force Account Code |
R e} #
= S;,rstem m =55 Force Authorization Code  []
----- T4 Line (4) PRsTNE N
..... @ E;tntrgl Urgg (81 BXEENE N
----- 5 ension TN E
----- § User(m “*'D*N'_ N
..... .ﬂ Group (0) PxTINE N
----- B Short Code (51) Bx5g Medi
----- @ Service (0] PXEN; N"@
----- 9 Incoming Call Route BX TN N"@
----- a@m Directory (0) , "
-7 Time Profile (0) ::SN' e
----- @l 1P Route (1) NN
----- B Account Code (0) BXFNEOD 00 Hel
----- % License (30) < > ==
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5.6. Extension

Assumption is that IP extensions (SIP and H.323) have already been created for users. Navigate to
Extension, select an (IP) Extension and then click on VVoIP tab. Ensure the parameters are being set
as shown in capture.

Configuration |Extension = H.323 Extension: 11204 2551 ef -2 Xlwv <[> §

_____ & BOOTP () D Extensil| Eencion VolP
i Operator (3 ;11200 2555

% Solut
.....ID UU':E':GD) ™ 11201 2556 IP Address 0 0 0 0
% Group(l) 11202 2557

B Short Code(45) | ™ 11203 2550 || MAC Address 0 0 0 0 0 00 Out Of Band DTMF
o Directory(D) ;11204 2551
17 Time Profile(0) |, 11205 2552 Codec Selection System Default s
Account Code(l Allow Direct Media Path

§5 UserRights(9)
&g Location(D) tS s G711 ULAW 64K
= SEQT VM G711 ALAW 64K
G.729(a) 8K CS-ACELP

? System (1)
47 Line (3) G.722 64K

= Control Unit
-4 Extension (B) wes
§ User(D)
-5 Group [0)
- @% Short Code (
- Service (0)
-3 Incoming Cz
-8 Directory (0)
£ Time Profile
il IP Route (1)
- Account Coc
W License (30)
55 User Rights ( Media Security Same as System (Preferred) ~
-~ ARS (1)
- Location (0) Advanced Media Security Options Same As Systemn
-5 Authorizatio
[#-%27 [PO 5P EXP

O Enable Faststart for
non-Avaya [P phones

[ Local Tones

Reserve License Mone ~

Supplementary Services Mone ~

RTP

RTCP

RTP

RTCP

SRTP_AES_CM_128_SHA1_80
SRTP_AES_CM_128_SHA1_32

Help
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5.7. User

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP line
defined in Section 5.4. To configure these settings, first select User in the left Navigation pane, then
select the name of the user to be modified in the center Group Pane. In the example below, the name
of the user is “H323-2551". Select the SIP tab in the Details Pane.

e The values entered for the SIP Name and Contact fields are used as the user part of the SIP
URI in the From header for outgoing SIP trunk calls. They also allow matching of the SIP
URI for incoming calls without having to enter this number as an explicit SIP URI for the
SIP line (Section 5.4). The example below shows the settings for user H323-2551. The SIP
Name and Contact are set to one of the DID numbers assigned to the enterprise from service
provider.

e The SIP Display Name (Alias) parameter can optionally be configured with a descriptive
name.

e If all calls involving this user and a SIP Line should be considered private, then the
Anonymous box may be checked to withhold the user’s information from the network.

e Click OK.

Configuration \ User i= H323-2551: 2551 e - X[ v <> &
o * BOOTP (8) i Mame Extensi

Operator (3) §rH323-2550 2530

=52 Solution fmH323-2551 2551

""" § User(3n) Button Programming Menu Programming  Mobility Group Membership Announcements SIP
..... 2% Group(1) §-H323-2552 2552

User Voicernail DND Short Codes  Source Numbers  Telephony Forwarding  Dial In - Voice Recording

Personal Directery  'Web Self-Administration

----- % Short Code (45) fmNoUser SIP Name |4693418145 | .
----- @ Directory(0) frcips-2535 23535 ) ]
£ Time Profile(0) :HSIPS-ZSSE 2556 SIP Display Mame (Alias) |H323-2551 |
----- #m Account Code(0) SIPS-3557 2557
..... {3 User Rights(9) i Contact |4693418145 |
""" i@ Location(0)
=% SEQT VM
559 System (1) [] Anonymous

----- <2 Control Unit {
----- A& Extension (B)
..... = User (7)

----- %% Group (0)

----- 8% Short Code (5
----- B service (0)

----- e Incoming Cal
----- @2 Directory (0)
----- 179 Time Profile ( =
----- ER P Route (1)
----- 8 Account Cod
----- . License (30) < N Help
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One of the H.323 IP Phones at the enterprise site uses the Mobile Twinning feature. The following
screen shows the Mobility tab for User H323-2551.

e The Mobility Features and Mobile Twinning boxes are checked.

e The Twinned Mobile Number field is configured with the number to dial to reach the
twinned mobile telephone, in this case 86139675205 including access code of 8.
e Other options can be set according to customer requirements.

----- B Short Code (43)
----- 25 Directory(0)

----- £ Time Profile(0)
----- | Account Codel(()
----- 5 UserRights(g)

""" i@ Location(0)

=59 SEQT VM

-5 Systern (1)

----- <2 Control Unit (&)
----- A Extension (6)

..... a User (7)

..... .u Group (0)

----- 8% Short Code (51)
----- B service (0)
Incoming Call Ro
Directory (0)
Time Profile (0}
IP Route (1)

8l Account Code (7
----- %= License (30)

----- §5 UserRights (9)
..... ( ARS (1)

----- 5 Location (0)

£

----- 'm Authorization Co
H-%2p PO SP EXP

fraMoUser
§sips-2555 2555

[ Internal Twinning

e Click OK.
Configuration ‘ User 7 H323-2551:; 2551° =R AR ARREYY
et E]OOTtP(S()BJ Name Bxtensi User Voicemail DND Short Codes  Source Mumbers  Telephony Forwarding  Dial In - Voice Recording
perator .
-39 Solution tﬁ:;: ;::10 ;::10 Personal Directory  Web Self-Administration
..... U 30 ) i i Mobili i
..... % G::LE](% aﬂHBEB-ZSSZ 2552 Button Programming  Menu Programming ohility  Group Membership Anncuncements SIP

<None>
§-sIps-25356 2556
§-sIps-2557 2557 1
Twin Bridge Appearances
Twin Coverage Appearances
Twin Line Appearances
Mobility Features
Mobile Twinning
Twinne.d Mo.bile Mumber |361396?5205
(including dial access code)
Twinning Time Profile <Mone>
Mobile Dial Delay (sec) |z

Mobile Answer Guard (sec) |0 =
[] Hunt group calls eligible for mobile twinning
[ Forwarded calls eligible for mobile twinning
] Twin When Logged Out

one-X Mobile Client

1 Mobile Call Control

Mobile Callback

LCancel Help
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5.8. Incoming Call Route

An incoming call route maps an inbound DID number on a specific line to an internal extension.
This procedure should be repeated for each DID number provided by the service provider. To create
an incoming call route, select Incoming Call Route in the left Navigation pane, then right-click in
the center Group pane and select New (not shown). On the Standard tab of the Details pane, enter
the parameters as shown below:

e Set the Bearer Capability to Any Voice.
e Setthe Line Group Id to the incoming line group of the SIP line defined in Section 5.4.

e Set the Incoming Number to the incoming number on which this route should match.
e Set Locale to United State (US English).
o Default values can be used for all other fields.
e Click OK.
Configuration ‘ Incoming CallR... |[i= 3 4693418145 of - X|v|<|>
R BOOTP (8) | LineGroup D Incoming M| Standard  Voice Recording Destinations
Operator (3)
452 Solution
..... a User (30) - = -
_____ % Group() Bearer Capability Any Voice
----- 9 Short Code (45) Line Group D 3 v]
----- 2 Directory(D) (.1 4693418145
- Time Profile(0) Incoming Number |469341 8145 |
----- 0 Account Code(0)
..... a ; User Rights(9) Incoming Sub Address | |
""" & Location(0) .
5 SEQT UM Incoming CLI | |
-5 Systemn (1) - - -
_____ 1 Line @ Locale United 5tates (US English)
----- <2 Control Unit (8) Priority 1-Low >
----- 4 Extension (6)
----- § User(m Tag | |
..... a Group (0)
@% Short Code (51) Hold Music Source System Source w
g Is:cr::neirfg)Call i Ring Tone Override |N0ne v|
----- = Directory (0)
----- 1 Time Profile (0)
----- El P Route (1)
----- Bl Account Code ()
----- % License (30) & > Help
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On the Destinations tab, select the destination extension from the pull-down menu of the
Destination field. In this example, incoming calls to Incoming Number on line 3 are routed to
extension 2551. Click OK.

Configuration | Incoming CallR... |[= 34693418145 5 BIX vl

o K poOTP(8) ~ i LineGroup 1D Incoming M| g4 dary Voice Recording  Destinations
Operator (3)

= Solution TimeProfile Destination Fallback Extension
""" § User@an » Default Value 2551 H323-2551 v
----- ﬂ Group(1)
----- 8 Short Code (43) .
----- = Directory(0) @3 4693418145

----- £ Time Profile(D)

----- Bl Account Code(0)
----- §5 User Rights(9)

""" & Location(0)

-J-#39 SEQT VM

-5 System (1)

----- T Line (4)

----- “=r Control Unit (8)
----- 4 Extension (6)
..... = User (7)

----- ﬂ Group (0)

----- B Short Code (31)
----- B Service (0)

----- 2 Incoming Call Reute
----- 2= Directory (0)
£ Time Profile (0)

----- Bl IP Route (1)
----- Bl Account Code (0

----- % License (30) 'S 3 Help
5.9. Save Configuration
Navigate to File = Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.
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6. Windstream Networks SIP Trunking Configuration

Windstream is responsible for the configuration of Windstream SIP Trunking service. The customer
will need to provide the IP address used to reach the Avaya IP Office at the enterprise. Windstream
will provide the customer the necessary information to configure the Avaya IP Office SIP
connection to Windstream. The provided information from Windstream includes:

IP address of the Windstream SIP proxy.

Supported codecs.

DID numbers.

IP addresses and port numbers used for signaling or media through any security devices.

7. Verification Steps
The following steps may be used to verify the configuration:

e Use the Avaya IP Office System Status application to verify the state of the SIP connection.
Launch the application from Start > Programs => IP Office = System Status on the PC
where Avaya IP Office Manager was installed. Select the SIP line of interest from the left
pane. On the Status tab in the right pane, verify that the Current State is Idle for each
channel (assuming no active calls at present time).

I Avaya IP Office System Status - SEQT VM (135.10.97.61) - [P Office Linux PC 10.0,0.0.0 build 550 — O X

IP Office System Status

Status  Utilization Summary Alarms

SIP Trunk Summary ~
Line Service State: In Service
Peer Domain Mame: sip:ff192.168.64.176
Resolved Address: 192.168.64.176
Line Mumber: 3
Mumber of Administered Channels: 10
Mumber of Channels in Use: 0
Administered Compression: G711 Mu, G729 A
Enable Faststart: Off
Silence Suppression: off
Media Stream: RTP
Layer 4 Protocol: UDP
SIP Trunk Channel Licenses: 128 . -
SIP Trunk Channel Licenses in Use: 0
SIP Device Features: UPDATE (Incoming and Outgoing)
Channel U... Call Current Timein Remote Co... Conn... Caller Other Party Directi... Round Receive Receive Trans... Trans...
Mumber Ref State State  Media ... IDor ... on Cal Trip... Jitter Pack..
1 Ide |00:0L... ~
2 Ide |22:41...
3 Ide |22:41...
4 Idle [22:41... v
Trace Trace Al Pause Ping Call Details Graceful Shutdown Force Out of Service Print...

Save As...

11:10:44 AM Online &
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e Select the Alarms tab and verify that no alarms are active on the SIP line.

AVAyA IP Office System Status

Status  Utilization Summary Alarms Reqgistration

Alarms for Line: 2 SIP interop-ex.sea.accessline.com

Last Date Of Error Qcourrences Error Description

Clear Clear all Graceful Shutdown Force Out of Service Print... Save As...

Online

e Verify that a phone connected to PSTN can successfully place a call to the Avaya IP Office
with two-way audio.

e Verify that a phone connected to Avaya IP Office can successfully place a call to the PSTN
with two-way audio.

e Using a network sniffing tool e.g. Wireshark to monitor the SIP signaling between the

enterprise and service provider. The sniffer traces are captured at the LANZ2 of the Avaya IP
Office.

8. Conclusion

The Windstream SIP Trunking passed compliance testing. These Application Notes describe the
procedures required to configure the SIP connection between Avaya IP Office and the Windstream
SIP Trunking service as shown in Figure 1. All feature and serviceability test cases were completed
successfully with observations noted in Section 2.2.
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9. Additional References

[1] Administering Avaya IP Office Platform with Manager, Release 10.0, August 2016.

[2] Avaya IP Office™ Platform Server Edition Reference Configuration, Release 10.0, Issue 04.AD,
August 2016.

[3] Deploying IP Office™ Platform Server Edition Solution, Release 10.0, August 2016.

[4] IP Office™ Platform, Using a Voicemail Pro IP Office Mode Mailbox, Issue 10D, May 2016.

[5] Using Avaya Communicator for Web, Release 1, Issue 1.0.6, May 2016.

Product documentation for Avaya products may be found at http://support.avaya.com. Additional IP
Office documentation can be found at;
http://marketingtools.avaya.com/knowledgebase/

Product documentation for Windstream SIP Trunking is available from Windstream.
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Avaya and the Avaya Logo are trademarks of Avaya Inc. All trademarks identified by ® and ™
are registered trademarks or trademarks, respectively, of Avaya Inc. All other trademarks are the
property of their respective owners. The information provided in these Application Notes is
subject to change without notice. The configurations, technical data, and recommendations
provided in these Application Notes are believed to be accurate and dependable, but are
presented without express or implied warranty. Users are responsible for their application of any
products specified in these Application Notes.

Please e-mail any questions or comments pertaining to these Application Notes along with the
full title name and filename, located in the lower right corner, directly to the Avaya DevConnect
Program at devconnect@avaya.com.
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